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Finding your way around

FINDING YOUR WAY AROUND

This guide describes how to configure SurfControl Web Filter for Citrix once you have installed Service Pack
2. Service Pack 2 enhances SurfControl Web Filter for Citrix to give you:

*  Secure LDAP communication between Web Filter for Citrix and the domain controller.
*  The ability to configure the port between the client and Web Filter for Citrix server.

*  Network installation of clients via group policy.

*  The ability to make the client invisible to the user.

*  Secure communication between the client and the server.

* Increased client deployment security.

For setting up rules that apply to Web Filter for Citrix clients see Chapter 8 - Rules Administrator of the Web
Filter Administrators Guide. Web Filter for Citrix users and hosts can be selected from the Who objects tab.

THE WEB FILTER FOR CITRIX ADMINISTRATOR

The Web Filter for Citrix Administrator (see Figure 1) is where you manage your SurfControl Web Filter for
Citrix clients. It contains a configurable description of each remote device with it’s settings.

@ surfControl Web Filter for Citrix Administrator - [localhost] JH[=]
File Edt Wiew Configure Tools Help

misa x| 2

¢ [ Desaription Offiine Action__| Unfiltered Ports | Fiter Sensitivity | Visibity Level _| User Name Host Name

[ mike cirix client illows Al [ -tometic B e [ ¢

< | ]
Description: mike citrix client Offling Actian: Allow Al a
Client Id; BCFACF7F-CA33-4D7E-BRBC-3+46A01 70718 Unfitsred Ports: Al Al -
Platform Type: Micrasoft Windows 2000 Advanced Server Filter Sensiivity: T Automatic -
Client Type: @8{in 32 Engish Yisiilty Level: = Medium -
Client Version: 2.1.0.82 User Hame: [T Ciient specfied =
Install Date: Today 11:30:13 Host Name: |;J Client specified j |cnmxv3
Last Logon Date: Today 14:27:14 PR abciza
Tamper Count; Hene Clear dlert Commit Changes,
Ready [Vclentls)  [1selected || [ 4

Figure 1 The Web Filter for Citrix Administrator

Once you can see your clients within the Web Filter for Citrix Administrator you can edit their filter settings.
When you select an individual client in the top pane of the Administrator, it’s details will appear in the bottom
pane.

Note: if you select multiple clients the only details that will appear in the bottom pane are those that
@/ are common to each client.

SurfControl Web Filter for Citrix SP2 Administrator’s Guide 1



Finding your way around

To see the Web Filter for Citrix Administrator Select Start > Programs > SurfControl Web Filter for Citrix >
Web Filter for Citrix Administrator.

Selecting Clients to view and/or configure

To view and configure the filtering of client devices, you need to select the client that you want to configure.
Select clients individually or in multiples, using the SHIFT or CTRL key.

*  Click the Find First button to find one client of a patticular type.

*  Click the Find All button to find a group of clients of a patticular type.

Procedure 1 Changing client properties
Step Action
1 Select the clients that need changing.
2 Change the properties in the Properties panel and click the Commit Changes button.
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Administrator Menus

ADMINISTRATOR MENUS

The following menu options are available in the Web Filter for Citrix Administrator:

FILE

The File menu enables you to open databases and close the Administrator.

Open...

The Open... menu enables you to open a database of Web Filter for Citrix clients to be administered by the
Web Filter for Citrix Administrator. Only Web Filter for Citrix compatible databases can be opened in the
Administrator.

Exit
Enables you to close the Web Filter for Citrix Administrator.

EDIT

The Edit menu enables you search, select and delete clients.

Find

Find enables you to use a keyword search to locate particular clients. If you have a lot of clients and only want
to configure those of a certain type, you can use Find to select only those clients that contain the criteria that
you are looking for.

Procedure 2 Searching for clients

Step Action

1 Choose Find... from the Edit menu or click |ﬂ on the toolbar.
2 The Find dialog box will appear.
O x| Floure2  Thefind dialog
Findwhat: || MREECEEE *  Find what:- enter the text you want to
Search Columns Find 4l | find.
¥ Description ¥ Client 1d *  Search Columns - select the check-
¥ Lser Name ' platform Type boxes that correspond to the columns
(3 doss | that you want to search.
3 Enter the text or characters that you want to be included in the search into the ‘Find what:’ text box.
4 Indicate which column you want to search by selecting the relevant ‘Search Columns’ check boxes.
5 Click Find First to have the first client that fulfills this criteria highlighted or Find All to have every
client highlighted.

SurfControl Web Filter for Citrix SP2 Administrator’s Guide 3
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Find Next

The Find Next menu item enables you to find the next Web Filter for Citrix client that matches the search
criteria.

Select All

Choosing Select All selects all of the clients in the Administrator.

Invert Selection

This reverses the selection status of the clients in the Administrator. For example if clients 2, 4 and 6 are
selected and 1, 3 and 5 are not, selecting Invert Selection will deselect clients 2, 4 and 6 and select clients 1, 3
and 5.

Delete Client

Delete Client removes the client from the Web Filter for Citrix Administrator. If you have not selected ‘Reject
new client installs’ in the Server Settings dialog, the client will reappear the next time it communicates with the
Web Filter for Citrix servet.

VIEW

The View menu enables you to specify how you want the Web Filter for Citrix Administrator to look by
adding or hiding toolbar buttons and the status bar. You can also use the View menu to change the columns
within the Administrator:

Toolbar
Select Toolbar to show the Shortcut buttons or deselect it to hide them.

Status Bar

Select Status Bar to show the status values at the bottom of the Administrator or deselect it to hide them.

Columns
To sort client data click the Heading at the top of the column. The data will be sorted into alphabetical order.
Clicking the column again will reverse the order of the sort. This menu contains two sub-menus:

* Reset Positions - If you have moved columns to different places in the table select this to restore all
columns to their original positions. To move a column to a different position, select the column heading
then drag and drop it into its new position. You can return it to its original position at any time by
choosing Columns > Reset Positions.

*  Reset Widths - Selecting Reset Widths restores the column widths to their default setting

Refresh

Selecting Refresh updates the information in the Web Filter for Citrix Administrator by refreshing the details.
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Administrator Menus

CONFIGURE

The Configure menu enables you to specify global attributes for clients as well as the location and scope of
your corporate Web Filter installations.

Server Settings

Server Settings - specify the global default user name and host name. and whether the Web Filter for Citrix
server is accepting new clients.

New Client Defaults

When a client is installed to the Web Filter for Citrix server certain default settings are used. You can change
these default values by setting up the New Clients Defaults dialog box. Any clients that are installed after this
point will contain these settings.

Procedure 3 Configuring New Client Defaults.

Step Action

1 Select New Client Defaults from the Configure menu.

2 In the the New Client Defaults dialog box, enter the following information:

¢ Offline Action: - set how the client will behave if the Web Filter for Citrix server becomes
unavailable. See “Client Details section” on page 10 for more details. The default is Allow All.

e Unfiltered Ports: - set how the client should behave towards ports that are not included for
filtering. See “Dealing with unfiltered ports” on page 12. The default is Allow All.

*  Filter Sensitivity: - set how much filtering is carried out. See “Setting filtering sensitivity” on
page 13 for more details. The default is High.

*  Visibility Level - set how much of Web Filter for Citrix the user sees. The default is Medium:
- Full - all features and pop-ups will be visible to the user.
- Medium - the Client Ul will be available but pop-ups will be disabled.

- Stealth - no features will be available to the user. Only pop-ups containing a critical message
will be shown.

*  Preferred Host Name: - set the name for the device that is being filtered. See “Host name"” on
page 14 for more details. The default is client specified.

*  Preferred User Name: - set the name for the user of the device that is being filtered. See “Visibility
Level” on page 14 for more details. The default is client specified.
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Step Action

Figure 3 New Client Defaults
B
vcv'ilaotﬁst::r\sfeetrt.ings to be given to each new client when it registers . oﬁ:llne Action: _ HOW clients behave If the server
goes offline.
Slilo e 1@ on ol = Unfiltered Ports: - How Web Filter for Citrix treats
Unfikered Eorts: | alowai [ | ports that are not included for filtering.
B i h . _ . .
F"tzrlienm:w I ron = *  Filter Sensitivity: - The strength of filtering.
Wisibility Lesel: il
s s [ Clom: socied | *  Visibility Level: - How muc_h of th_e client interface
prefenad se N B cort oo r the user sees. The default is medium.
*  Preferred Host Name: - The name of the device
@ | [ G being filtered.
*  Preferred User Name: - The name of the user of the
device being filtered.
3 Click OK.

Client Upgrade Details

Not available in this release.

Adding Corporate Web Filters

Not available in this release.

TooLs

The Tools menu enables you to set passwords and override them in the event of problems.

Password Bypass Generator

To uninstall a client you need to supply the password that you entered during the client installation. If you
forget this password you will have to use Password Bypass to override the original password and uninstall the
client without it.

Procedure 4 Using Password Bypass Generator

Step Action

1 If you find, when you are asked for your password that you cannot remember it, click the Password
Bypass button in the Uninstall Password dialog on the client.

Figure 4 Uninstall Password

e 0
¢ Password - Enter the Client password.

Password Bypass. ..
e Password Bypass... - Start to generate a bypass for this
password if you can’t remember it.
2 You will see a Password Bypass dialog which carries a code in the Challenge Code edit field.
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Step Action

3 Go to the Web Filter for Citrix Administrator select Tools > Bypass Generator.
4 Copy the Challenge Code from the client into the ‘Challenge Code:’ edit field of this dialog.
Figure 5 Password Bypass Generator
x|
Ehalbna ot presentad wihi e clent. (ki Sererate il * Challenge Code: - The code that you copy from the

then calculate the respanse code.

Client Password Bypass dialog.

The code maybe entered with or without the separating spaces and

dashes, * Response Code: - The code that appears when you click

Challenge Code: I | Generate
Response Code: — * Generate - Generates the Response Code.

0|

5 Click Generate.
6 A code will appear in the ‘Response Code:’ text box.
7 Go back to the client and copy this Response Code from the server into the ‘Response Code:’ text box

of the Client Password Bypass dialog.

8 Click OK to proceed with uninstalling the client.

Set Server Pass-phrase

During the installation of the Web Filter for Citrix client on to a user’s device, it registers with the Web Filter
for Citrix server and it’s details are written to the Web Filter for Citrix database. During this registration
process the server passes a pass-phrase (created during the installation of Service Pack 2) to the client. The
following illustrates how this pass-phrase can be used:

PROBLEM

* The Web Filter for Citrix database has been deleted/corrupted and cannot be restored. The server
administrator creates a new database.

*  The client attempts to log onto the server to ask for a categorization. The logon fails because the new
database contains no details of this client (the client did not register with THIS database during
installation).

* The client attempts to re-register. Re-registration requires that the client’s details already exist in the
database. As this is not the case, the client is not allowed to log on to the Web Filter for Citrix server.

SOLUTION
The Set Server Pass-phrase deals with a situation like this in the following way:

*  After the administrator has created the new Web Filter for Citrix database, he assigns the same pass-phrase
to this database as the one used for the old database that no longer exists (using the Set Server Pass-phrase

dialog).
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*  The client tries to log on to the server for a categorization which fails (because there are no client details in
the database). The client obtained the pass-phrase during the client upgrade process. It now passes this
pass-phrase to the server.

*  The server checks that the password matches the one assigned to the new database (which it does because
the administrator has assigned the old pass-phrase to the new database), then writes the client’s details to
the new database. It then allows the client to log on.

Note: Once you have configured the server to use a new database, you MUST restart IIS. This is to ensure
@ﬁ that the scnmISAPIExt.dll picks up the new settings.

Setting a new Pass-phrase. If you have created a new database using the Database Creation Tool the new
database will not have a pass-phrase assigned to it.

Procedure 5 Setting a new Pass-phrase
Step Action
1 Opening the Web Filter for Citrix Administrator, will show a message telling you that no Server Pass-

phrase has been set. Click OK.

2 In the dialog that follows, enter a pass-phrase for the new database. The ‘Enter existing pass-phrase:’
is grayed out because a pass-phrase has not yet been assigned to this new database.

3 Enter a new pass-phrase and confirm it: The new password must be between 8 - 16 characters long.
Figure 6 Set Server Pass-Phrase
x
Set a pass-phrase to allow clients to automatically re-register with . e . . .
the server *  Enter existing pass-phrase - This will be grayed out if no
Enter existing pass-phrase: I paSS‘phrase haS been set.
Enter now pass-phrase: || *  Enter new pass-phrase - The new pass-phrase that you

want to add.

Confirm new pass-phrase: I

*  Confirm new pass-phrase - The same pass-phrase

ok | concal | entered again for confirmation.
4 Click OK. The next time the client requests a URL category from the server it will be forced to re-logon.

The pass-phrase will then be passed to it.
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Administrator Menus

Changing a Pass-phrase. If you need to change your pass-phrase you can use the Set Server Pass-phrase to
do this.

Procedure 6 Changing a Pass-phrase
1 Select Set Server Pass-phrase from the Tools menu.
2 Enter the old password into the ‘Enter existing pass-phrase:’ text box.
3 Enter the new pass-phrase and confirm it: The new password must be between 8 - 16 characters long
4 Click OK. The next time the client requests a URL category from the server it will be forced to re-logon.
The new pass-phrase will then be passed to it.

HELP

About SurfControl Web Filter for Citrix Administrator

The About box contains information such as the version number of the Web Filter for Citrix installation, the
name of the category database and how many days are left on your subscription.

SurfControl Web Filter for Citrix SP2 Administrator’s Guide 9



Client Details section

CLIENT DETAILS SECTION

CLIENT DESCRIPTION

This reflects the description added during the client’s installation. You can edit the initial description in the
Description field in the bottom pane. Details relating to the client are shown in Table 1. These are specified by
the client and cannot be edited in the Web Filter for Citrix Administrator.

Table 1 Client Details

Field Description

Client ID Unique ID that helps locate a specific client installation. This ID is also visible in the
client. See “Client properties” on page 16 for more details.

Platform Type The client operating system. It is useful when locating and/or grouping installations.

Client Type Identifies the Processor, Operating System Description and Language variant of a Web
Filter for Citrix client.

Client Version Identifies the version number of the Web Filter for Citrix client.

Install Date Date on which the Web Filter for Citrix client software was installed on the selected
device.

Last Logon Date Date the client last made an Internet request that was logged by the Web Filter for

Citrix Administrator.

Tamper Count Tamper count - Should the client detect an unauthorized change to any of the offline
log files or the gateway URL in the registry, it will notify the server that a tamper has
occurred. Once the server has been notified that the client has been tampered with, it
will increase the tamper count for that client.

Password Password that was supplied during the client’s installation process and is required if
you uninstall the client.

10 Administrator's Guide SurfControl Web Filter for Citrix SP2
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OFFLINE ACTION

There may be times when the Web Filter for Citrix server is not available to the client, perhaps because of
connection difficulties or maintenance. When this happens the client will try to contact the server on a regular
basis (every five minutes) while connected to the Internet, until it can re-connect to the server. If the server is
busy this can take between ten to sixty minutes. While the server is unavailable the client will be unable to send
Web requests to the server for categorization so must deal with these requests itself. The client can be set to
perform one of the following: Allow All or Block All

Procedure 7 Setting Offline Action

Step Action

1 Select the client/s that you want to set the offline action for.
2 Click the arrow on the Offline Action: list to expand it:
Figure 7 Offline Action List
Offline Action: & pllow 4l j
Unfiltered Ports: g M e  Allow All - every Web request will be allowed
OC|
Filker Sensitivity: ] Automatic 1) (the default).
isibiliy Level: | Medium | *  Block All - every Web request will be blocked.
User Mame: I ;J Client specified j
Hast Mame: I;J Client specified j CITRI=ZNS
Password: abc123
3 Choose the type of Offline Action that you require, from the list.
4 Click Commit Changes to add the new Offline Action setting to the client in the Web Filter for Citrix
Administrator.

SurfControl Web Filter for Citrix SP2 Administrator’'s Guide 11
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DEALING WITH UNFILTERED PORTS

Filtering of ports depends on what rules you have created and what ports are available to be monitored. There
are three ways in which these unknown ports can be dealt with:Allow All, Block All and Filter.

Procedure 8

Setting Unfiltered Ports

Step Action

1 Select the client/s that you want to set the unfiltered ports behavior for.
2 Click the arrow on the Unfiltered ports: list to expand it:
| Figure 8 Unfiltered ports list
Offline Action: [ & allow al =l Unfiltered ports actions:
Uil sk @ alow Al [ e Allow All - allow access to all unfiltered
Filter Sensitivity: g ports without contacting the Web Filter
isibity Level: L Fiker for Citrix server to see if there is a rule set
U e & Client spedified = up for the port (this is the default).
Host Hame: {1 Client: speciied x| |=rrome *  Block All - block access to any unfiltered
] ahc123 ports without contacting the Web Filter
for Citrix server to see if there is a rule set
up for the port.
*  Filter - contact the Web Filter for Citrix
Server to see if any rules are set to apply
to all ports.
3 Choose the type of action that you require for unfiltered ports, from the list.
4 Click Commit Changes to save the new Unfiltered Ports: setting.

12 Administrator's Guide
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SETTING FILTERING SENSITIVITY

Filtering sensitivity enables you to set how much filtering is carried out by Web Filter for Citrix clients.
Reducing the level of filtering can speed up performance on slow connections, but of course at the same time
less traffic is filtered. Priority can be assigned on four levels High, Medium, Low and Automatic.

Procedure 9

Setting up Filter Sensitivity

Step Action

1 Select the client/s that you want to set the filtering sensitivity for.
2 Click the arrow on the Filter Sensitivity: list to expand it:
Figure 9 Filter sensitivity list
| 9 y

Offline Action: |® alow el | Filter Sensitivity strengths:

Unfiktered Ports: | @ llow Al [ * High - all non-HTTP ports and all HTTP

Filer Sensitivity: | € High | requests are categorized. There may be a

wisibiliy Level: o N performance impact if the client is making

T 3 [ﬁ:‘“m — a lot of requests on a slow internet

Host hame: 1 sutomatic _ e connection.

Fo— T *  Medium - all non-HTTP ports are
categorized but only HTTP page requests
are categorized while Images/sounds/style
sheets, and XML requests are not
categorized.

* Low - all non-HTTP ports are categorized.
For HTTP requests, the URL will be
categorized and, if allowed the domain
level part of the URL is cached for 3
minutes.
*  Automatic - the client chooses High,
Medium or Low based on the average Web
Filter for Citrix server response times and
pre-configured thresholds.
3 Choose the level of filtering from the list.
4 Click Commit Changes to save the new Filter Sensitivity setting.
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VISIBILITY LEVEL

You can set Web Filter for Citrix to hide some or all of its features from the user. There are three levels of
visibility: Full, Medium and Stealth. If the client tries to access a port that is blocked, the user will see a warning
pop-up, regardless of the visibility setting.

Procedure 10 Setting up Visibility Level

Step Action

1 Select the client/s that you want to set the visibility level for.
2 Click the arrow on the Visibility Level: list to expand it:
Figure 10  Visibility Level list
Offline Action: I & allow Al j
Unfilered Ports: | @ allow Al | Visibility levels:
Fiker Sensiiviey: | Hioh [ ¢  Full - Full visibility. All features and pop-ups
visibility Level: 4 Ful | will be visible.
e e ; ﬁzdium *  Medium - The user interface will be visible
[tee e @ stealth AFHOME to the user but pop-ups will be disabled
though critical messages will be shown.
This is the default setting for a new client.
»  Stealth - No features will be visible to the
user. Only pop-ups containing critical
messages will be shown.

Note:  The client interface will be displayed
when an upgrade is available, even if
the client is set to Stealth mode.

3 Choose the level of visibility from the list.
4 Click Commit Changes to save the new Visibility setting.
User name

The User Name is the name that the Web Filter for Citrix server uses when checking Internet requests against
the rule set. It must be set to Client specified, otherwise the Web Filter for Citrix server will not be able to
check the user name against rules.

Host name

The Host name specifies which Citrix server is handling an Internet request, so you can create rules to control
what requests a specific Citrix server is allowed to make. It must be set to Client Specified otherwise the Web
Filter for Citrix server will not be able to check the host name against enabled rules.

PASSWORD

This is the password that is needed to uninstall the Web Filter for Citrix Client.
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OTHER CONFIGURATION

Once you can see your clients within the Web Filter for Citrix Administrator you can select and edit any of
them. These clients can then be added to SurfControl Web Filter for Citrix rules so that you can apply your
company filtering policy to them.

PORTS THAT CAN BE FILTERED

To reduce the amount of communication between Web Filter for Citrix clients and servers, the clients only
communicate activity on those TCP ports of interest. To perform filtering on a specific port, an appropriate
protocol/port ‘Where” object must be applied to rules. Those rules that do not contain a protocol/port
‘Where’ object are assumed to apply to HTTP ports only. The SurfControl Web Filter for Citrix client only
filters ports that appear in active rules.

PORTS THAT CAN BE MONITORED

You can set the protocols to be monitored or unmonitored (see “Monitoring Specific Protocols” in Chapter 6
of the Web Filter for Citrix Administrator’s Guide for more information). The SurfControl Web Filter for
Citrix client both filters and intercepts activity on those ports chosen to be monitored within the SurfControl
Monitor, and informs the Web Filter for Citrix server.

Monitoring issues with Web Filter for Citrix

In the Site Details and User Details panes, the ‘Bytes Sent’, ‘Bytes Received’” and ‘Duration’ fields will not
display data because of the way in which the Web Filter for Citrix client and server communicate.

SECURITY AND WEB FILTER FOR CITRIX

SurfControl Web Filter for Citrix now offers support for secure connection:
*  Between the Web Filter for Citrix server and your LDAP server

¢ Between the Web Filter for Citrix server and client.

Web Filter for Citrix server and LDAP server
A secure connection can now be made between the Web Filter for Citrix server and your LDAP server. You

can change the security setting specified during installation, by editing the SecureConnection registry setting,

Procedure 11 Changing the registry setting

Step Action

1 Open the registry using regedit and navigate to:
HKEY_LOCAL_MACHINE\SOFTWARE\SB\SurfControl Scout

2 Set the SecureConnection DWORD value:
e 1 -gives a secure connection though there will be an impact on connection speed.
e 0 - connection is faster but unsecure.

SurfControl Web Filter for Citrix SP2 Administrator’'s Guide 15
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THE WEB FILTER FOR CITRIX CLIENT

If a client is not set to Stealth it will inform any user of any change in the way it is filtering. If a request is
denied the user will see an appropriate Deny page corresponding to the rule that has been triggered. Non-
HTTP requests (including HTTPS) will show a pop-up window containing a message if the visibility level on
the client is set to 'Full'. These will also be recorded in a Message history window with the most recent
messages at the top, as in . These messages are not permanently stored.

Note: No client properties can be seen if the client visibility is set to Stealth.

s
W

CLIENT STATUS ICONS

Once the Web Filter for Citrix client is installed on the Citrix server your users will see an icon in the status
area, as long as the client visibility is not set to Stealth. The available icons are described in Table 1:

Table 2 Client Icons

Icon Description

The Web Filter for Citrix Server is offline, and offline action is set to Allow All.

Server is offline, and offline action is set to Block All.

The product Icon. This is used while the client is using the Web Filter for Citrix Server for filtering.

The client is waiting for the user to access the Internet before trying to log on to the Web Filter for
Citrix server.

CLIENT PROPERTIES

Web Filter for Citrix client properties can be seen by double-clicking the Web Filter for Citrix system tray icon
(see Figure 11). You can also right-click the icon and select Open from the pop-up menu. This will launch the
Web Filter for Citrix dialog box which contains the following tabs:

B W E N

e General

*  Messages

e About
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The Web Filter for Citrix Client

General

The General tab contains three sections:

SurfControl Web Filter for Citrix
Gaeneral |Messages I About I

Details

Skatus: Filtering using SurfControl Web Filker For Citrix sel
Client I BCRACFIF-CA33-4D7E-B3BC-3446A0170716
Filker Sensitiviey:  Automatic { High )

(Cakeqgorization Skatiskics
Server Response (Last); 5313 ms

Server Response (Average): 3606 ms

Actions

| Synchronize with Server I

Close |

Figure 11 Web Filter for Citrix General tab

Details - this shows a summary of the Web Filter for Citrix client settings, showing how filtering is set up,
the client ID (this can be given by the user to an administrator or Technical Support so that they can
identify the device within the Web Filter for Citrix Administrator) and the level of filtering sensitivity. See
“Setting filtering sensitivity”” on page 13 for more information on this setting.

Categorization Statistics - every time an Internet request is made the Web Filter for Citrix client contacts
the Web Filter for Citrix server to have the request categorized and have any appropriate rules applied.
‘Server Response (Last):” shows how quickly the server responded to the client’s last request while ‘Server
Response (Average):” gives an average of the speed of communication based on the response times it has
collected. If the last categorization failed the last response time will be preceded by the word Failed’.

For example
—  If the last categorization took 10 ms: Server Response (Last) 10ms.
—  If the last categorization failed: Server Response (Last) Failed 65000m:s.

Actions - clicking Synchronize with Server immediately updates the client with any client side changes
made on the Web Filter for Citrix server.

/ Note: Clicking Synchronize with Server will not update the last response time.
i
"
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The Web Filter for Citrix Client

Messages
Every time there is a change in the way the Web Filter for Citrix client is filtering it will display a message
relating to what has occurred (see Figure 12). These messages are stored in the Messages pane with the most

recent at the top:

surfControl Web Filter For Citrix

General Messages |About I

ylnformatinn 15122005 14:31:33 « |
Filtering using SurfContral Web Filker For Citrix server

él) Infarmation 15/12/2005 14:30:48

Filtering - Allaws All

ylnformatinn 15f12/2005 13:20:22
Filtering using SurfCaontral Web Filker Far Citrix server

él) Infarmation 15122005 13:29:12

‘Waiting For Internet activity, -

Close |

Note: If the client visibility is set to Medium, only messages concerned with blocked ports, tampers and

The About tab (see Figure 13) tells you the version number of the product and can be used as a reference for

Figure 12 Web Filter for Citrix Messages tab
@/ upgrades will be displayed.
About
upgrading etc:
surfControl ¥Web Filter For Citrix [ x|

General | Messages :F

E SurfContral Web Fiter for Citrix

Client Yersion: 2.1.0.52
Copyright © 1996-2006 SurfControl plc,

All rights reserved.

ol |

Clase |

Figure 13

Web Filter for Citrix About tab
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The Web Filter for Citrix Client

CLIENT SECURITY

During installation, the Web Filter for Citrix server’s contact information is stored in the registry of the client
machine as the Gateway URL. Some users may try to change this URL to avoid being filtered. The client can
detect unauthorised changes and automatically repair invalid entries. It does this in the following way:

*  If the gateway URL in the registry is not formed correctly, it will instantly be replaced with the last gateway
URL that was used by the client to successfully contact the server. A tamper will be logged.

* If the gateway URL contained in the registry is valid but cannot be contacted, the client will enter it's
default offline action state. It will then check the gateway URL periodically for a specified period of time
(24hrs by default).

*  If the server cannot be contacted after the specified time period, the gateway URL in the registry, and the
last successfully connected gateway URL will be compared.

— If the two are different, the gateway URL in the registry will be changed to match the last successful
gateway URL. A tamper will be raised and the client will attempt to connect to the server using the
updated gateway URL in the registry.

—  If the two gateway URL's are the same, the client remains in it's offline state and will petiodically poll
the server.
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The Web Filter for Citrix Client

GROUP POLICY AND CLIENT CONFIGURATION

It is now possible to use Group Policy to configure the Web Filter for Citrix server (and port) to be used by
clients. Procedure 16 details the steps that must be followed in order to add the new SurfControl template to
the Administrative Templates within a Group Policy Object, as well as how to configure the new server

information.

The following instructions assume that you are familiar with Active Directory and using the Microsoft Group
Policy Manager to apply policies to machines or groups of machines.

Procedure 12

Applying Group Policy to the Gateway URL

Step Action

1 Open Group Policy Manager on the Web Filter for Citrix server.

2 Right-click the Default Domain Policy object and select Edit.

3 In the Group Policy Object Editor select Computer Configuration > Administrative Templates.

4 Right-click and select Add/Remove Templates..

5 In the Add/Remove Template dialog that follows click Add.

6 Navigate to the Scmfcli.adm file. By default this will be stored in:
C:\Program Files\SurfControl\Web Filter\Tools

7 Select the file Scmfcli.adm and click Open.

8 Click Close in the Add/Remove Templates dialog.

9 Expand the Administrative Templates folder in the Group Policy Manager and you will now see a list
of directories beneath it.

10 Select SurfControl Web Filter for Citrix Client then select Server URL in the right-hand pane.

11 Click the Properties hyper-link.

12 In the dialog that follows select the Enabled option. This will enable the URL text box underneath.

13 Enter the following URL:
<protocol>://<server.domain:port>/scnmgw/scnmisapiext.dll
where <protocol> is either http or https and <server.domain:port> is the name of your server
and domain. The optional port specification, :port, enables you to use a different port to the
defaults of 80 for http and 443 for https.
Note: Do not alter the name, or the path to, the dll.
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The Web Filter for Citrix Client

Step Action

Server URL Properties

Setting | Explain |

M Server UAL

21

€ Mot Configured
& Enabled
" Disabled

URL |ver.domain> .coméscnmgu/senml SAPIE . il

Bievious Setling. | | Weweting. |

ok | Coancel |

Apply

Figure 14  The Server URL Properties dialog

Not Configured - no Group Policy URL has been added.
Enabled - the Group Policy URL will override the default
Gateway URL setting in the registry.

Disabled - the Group Policy URL has been added but it
has been disabled. The default Gateway URL will be
used.

URL: - the URL to the Web Filter for Citrix server.

14 Click OK.

CONNECTIONS BETWEEN CLIENT AND SERVER USING SP2

If you are using IIS v5.0, once a connection to an ISP is established it is maintained and remains open
indefinitely until the client logs off. This may be a problem if you have to pay for your network use on a ‘pay
for time used’ basis. This is not an issue with 1IS v6.0 so upgrading to this 1IS version should fix the problem.
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Troubleshooting

TROUBLESHOOTING

If you are encountering difficulties with a client, we recommend that you perform the following procedures in
the order listed. It is advisable to retest the client between each step:

*  Try closing and restarting the problematic application.

*  Open the Web Filter for Citrix client UI, and click the Synchronize with Server button.
*  Restart the computer.

*  Check the Web Filter for Citrix Web site for an up to date list of known problems.

*  Re-run the Web Filter for Citrix client setup and try the Repair option.

¢ Uninstall the Web Filter for Citrix client software, reboot and then re-install the software.

CLIENT NOT FILTERING

Web Filter for Citrix has the intelligence to know when it is in the company environment so that it will switch
off and leave the filtering to the company web filter. It does this by recognizing the range of IP addresses that
it is exposed to and recognizing that it is within it’s own network. However, companies can use ranges of IP
addresses which can be duplicated across different companies. If the Web Filter for Citrix client should go into
an environment that consists of IP addresses within the same range of those of the company from which it
originates then it will think that it is now within its own company and will switch off.

CLIENT NOT PICKING UP CHANGE TO OFFLINE ACTION

When a Web Filter for Citrix client cannot communicate with the Web Filter for Citrix Server, perhaps because
the server is offline, the Web Filter for Citrix client applies filtering to the device depending on the Offline
Action that was present within the Web Filter for Citrix Administrator at the last successful connection to the
Web Filter for Citrix Server. This means that, although you may change the Offline Action for a particular
client on the Web Filter for Citrix Administrator, this change will only come into effect once the client has
been able to successtully logon to the Web Filter for Citrix server and pick up this new configuration setting,
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